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Information Security

Notice!

This document is classified as “Restricted”. Restricted information is intended for Siemens’
employees and third parties (e.g., suppliers, customers) collaborating with Siemens only. This
means that it is possible to share information in this document with third parties that are
interested in our product on a “need-to-know” basis. However, distributing this document to
the public or publishing it on the internet is prohibited.
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1 Online Support

Click the following link for technical support:
http://www.siemens.com/lowvoltage/technical-support

Click the following link for the list of all FAQs, Hot fixes, and Service Packs:
www.siemens.com/Powermanager/support

For additional information to work with Powermanager, refer to the Powermanager
manual/Help.

1.1 Security Information

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines, and networks.

In order to protect plants, systems, machines, and networks against cyber threats, it is
necessary to implement —and continuously maintain — a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines, and networks. Such systems, machines and components should only be connected
to an enterprise network or the internet if and to the extent such a connection is necessary
and only when appropriate security measures (e.g., firewalls and/or network segmentation)
are in place.

For additional information on industrial security measures that may be implemented, please
visit https://www.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more
secure. Siemens strongly recommends that product updates are applied as soon as they are
available and that the latest product versions are used. Use of product versions that are no
longer supported, and failure to apply the latest updates may increase customer’s exposure to
cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under https://www.siemens.com/cert.
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2 Overview

Powermanager allows you to migrate projects of Powermanager V3.6 HF1 to Powermanager V5.1
or higher.

This process includes migration of configurations and data of the projects. Configurations of the
project including all device, report, and system settings and system trends are part of the
migration operation. Archived data over required period for selected devices is also a part of this
operation.

NOTE: For the ease of reference, all Powermanager versions above V5.1 will be referred as new
Powermanager.

You can perform this operation by using the migration tool. The migration operation consists of
two key workflows:

- Export from Powermanager V3.6 HF1: Allows you to select the configurations and the data
to be migrated from Powermanager V3.6 HF1 to new Powermanager.
NOTE: You should have Powermanager V3.6 HF1 to perform the export. Upgrade to
Powermanager V3.6 HF1, if you are using an older version of Powermanager.

- Import to new Powermanager: Allows you to import the exported files from
Powermanager V3.6 HF1 to new Powermanager.
NOTE: You should have new Powermanager to perform the import. Upgrade to new
Powermanager if you are using an older version of Powermanager.

Migration Rundown:

To save time, we recommend you perform the procedures involved in migration workflow in the
following sequence:

Configuration Export
Configuration Import
Data Export

A wnN e

Data Import

new Powermanager and Powermanager V3.6 HF1 must be available in two different machines to
perform the procedures in the recommended sequence. Refer section 5.1 Hardware Category
Definitions in GettingStarted_pm_8.0 document for hardware requirements. Ensure that the
machines involved in the migration process are in the same time zone.

NOTE: To transfer the exported folders from one machine to another, you are recommended to
have USB stick or USB Hard disk.

Below are few important details to be noted before continuing with the migration operation:

e Only server projects can be migrated. If you have an existing client setup, you must setup
the client afresh in new Powermanager.
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e Custom panels are not included in this migration operation. Refer new Powermanager

Help for more information on working with Graphics Editor to create similar templates.

e The device types that are not supported in new Powermanager but supported in

Powermanager V3.6 HF1 must be imported as Third-party device types in new

Powermanager. Refer Prerequisites for Import section below for more information.

e Device and Area/System level device type configuration are not migrated for Third-party
device types, Classic device types (PAC1500, 3VL COM21, GMD), SEM3 and PAC1200.
However, Archival configuration for the devices will be migrated in case the measurement

point is selected for data migration and data is available.

e The migration of the distributed system must be done for each project separately.

If the distributed project has source elements from another distributed project, then

those source elements will not be migrated and has to be re-configured in new

Powermanager system after migration.

Migration of devices is handled as below:

Device Migration Comments
Supported

PAC Devices 4 PAC1500 is migrated as a third-party device type. Refer
Prerequisites for Import section for more information.

SEM3 v -

SICAM Devices 4 P850 and P855 will be migrated as PAC5100 and PAC5200
respectively.

Breakers v 3VLCOM21 is migrated as a third-party device type. Refer
Prerequisites for Import section for more information.

Generic Modbus v This device type is migrated as a third-party device type.

Device Refer Prerequisites for Import section for more information.

Manual x -

Measuring Device

Virtual Devices v

(Logical Devices)

e Virtual devices include:
- Average Value
- Calculation Value
- Virtual Counter
- Converter
e KPlis migrated as a virtual device type.
e  Virtual devices are not listed for data export. All the
result values are selected for export.
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Monitoring x
Functions

Monitoring functions include Limit Control and Load
Monitoring.

Third-party 4
Devices

(XML imported
Third-party Device
types)

e The descriptions of Areas and Sectors are not migrated from Powermanager V3.6 HF1 to

new Powermanager.

e System and Area level configurations of PAC5100 and PAC5200 device types are
considered for P850 and P855 device type respectively in new Powermanager.

e (OPC UA/DA and MindSphere configurations are not migrated to new Powermanager.

e Manually corrected values are migrated.

e Alarm configuration of 3VLCOM21, PAC1500, GMD and third-party device types (xml

imported device types) will not be migrated. If necessary, reconfigure the alarms after

migration.

Powermanager, Migration Tool
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3 Export from Powermanager V3.6 HF1

This section provides information on the export operation required for migration.

Pre-export Checklist:

e Ensure you have sufficient disk space available for the export operation.

e Archive backups of Powermanager V3.6 HF1 should be re-mounted if needed for data

export.

e Ensure you take project and data backup before migration.

3.1 Prerequisites for Export

Login to Powermanager V3.6 HF1 and verify all the required configurations and data of the project

to be migrated are available. Perform the following steps to run the Powermanager Migration

Export Tool.

e Download and unzip the file containing the Migration Tool from the SIOS portal.

“ HORE ol

# Quick access
m Desktop
& Downlosds
Documents
= Pictures
Archrve
dplist

Local Disk (C:)

f OneDrve
= Thiz PC

# Network

This PC

Migration Configur

Wiew

Local Disk {(C:) Migration Tool Project_Export_Tool »
[ .

dplist

msg

panels
scnpts
pmMigration

e Run the pmMigration batch file as administrator.
- You will be prompted to enter the project path.

8 of 35

Powermanager, Migration Tool
L1V30600299C | Edition 10.2024



e Select the path of the project you want to migrate.
The path can be like the below example:
C:\SENTRON/\ProjectName

e Enter the project path and click Enter.

B C\Windows\System 32\ crnd.exe - o ®
. the pa

e Stop the project and close all Powermanager applications and consoles to proceed with
migration.

NOTE: The Powermanager Migration Export tool is available in English and German languages.
The language will be selected by the tool depending on the available operating system. The
language is set to English for all operating systems other than German.
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Restart the project to be migrated.

- The Powermanager Migration Export tool login screen appears. The Powermanager

Migration Export tool is added as a new User Interface (number 10) in the Powermanager

Console.

. powermanager: Console - O X
4| 4|2 8 & 7 D P
Project

DEMO_MIGRATION_PM3X

~ B B =

~ Manager - (Frocess Monitor: Starting project) —

St Descriplion Mo Options
Archive Manager 3 -um 3
Archive Manager 4 -pum 4
Archive Manager 5 -mum5S
Archive Manager 6 -num B
Archive Manager 7 -num7
Archive Manager 8 -numd
Archive Manager 9 -num9
Event Manager 1 -dbg 18
Control Manager 1 -fpvss_scripts
Iodbus Driver 1 «num 1
odbus Driver 2 -pum 2
Confrol Manager 2 -rum 2 -f pm

User Interface 1
0 User Intadace 2

Control Manager 3

Control Manager 4
0 Control Manager 1 -extend -Loa
0 OPC DA Sarvar 2
0 OPC UA Server 1

Disteibution Manager 1
0 User Interfaca 3 -m gedi -user n
FU&EI Interface 10 -num 10 -p visi ¥

< >

Enter the Username and Password used to login to Powermanager V3.6 HF1 project to

login to the migration tool.

Fovvermanager Migration

B

Domain name: DESKTOR-CEHIENL

Password:

Confirm Cancel

B vision_1: vision\pm'Migration\pm_Migrat.. — O

User name: | | !

b

NOTE: You must be a Powermanager V3.6 HF1 Admin user to login to the Powermanager

Migration Export tool.
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The Powermanager Migration Export tool is now available.

B Vision ¢ i
Configuration Export | Data Export

00— —8———18

Devices Report Templates Miscellaneous Export

Devices | Report Templates Miscellansous  Export

Languages
Language 1 & Language 2*
Devices
Select Device name Device type Device Group Area Sector [}
GMD VB Standard Devices DefaultArea
p850_P2 P850 Standard Devices DefaultArea
PAC1200_project? PAC1200 Standard Devices PACdevices
PAC1500_P2 PAC1500 Standard Devices PACdevices
PAC1661_P2 PAG1651 Standard Devices PAGdevices
pact651_p2 PAC1651 Standard Devices DefaultArea
PAC1661_P2_1 PAC1661 Standard Devices DefaultArea
PAC1662_P2 PAC1661 Standard Devices PACdevices
PAC1665_P2_1 PAC1665 Standard Devices DefaultArea
PAC1682_P2_1 PAC1682 Standard Devices DefaultArea
PAC2200_P2 PAC2200 Standard Devices PACdevices
PAC3200_P2 PAC3200 Standard Devices Area_Level PAC
PAC4200_P2 PAC4200 Standard Devices System_Level
SEM3_P2 SEM3_SEM3 Standard Devices PACdevices
Manual_measure_P2 Device Standard Devices DefaultArea v
Notes 1. Manual Measuring Device, Load Monitoring, and Limit Control device types are not supported for migration.

2. Generic Modbus Device, 3VLCOM21, and PAC1500 device types will be considered as third party device ypes in new powermanager after migration.

Third Party Device XMLS

Third Party Device Type Number of Devices for the device type Select XML file used for creating the third-party device type Path of XML
CamilleBauer EMMOD_201 0 Browse C:/TPD/CamilleBauer_ EMMOD_201_v1.0 1/CamilleBauer EMMOD_201
PAC3200TPD 1 Browse C:/TPD/PAC3200TPD/PAC3200TPD xml
SICAM_Q100 1 Browse C:/TPD/SICAM_Q100_v1.0 0/SICAM_Q100 xml|
Save
Powermanager, Migration Tool 11 0f 35

L1V30600299C | Edition 10.2024



3.2 Configuration Export

Ensure that all the prerequisites mentioned in the Prerequisites for Export section are met.

Perform the following steps for Configuration Export.

NOTE: We recommend you stop all device communication before proceeding with the export

operation.

Devices Tab

Select the required description language from the Languages section.

Languages

Languages 1 English Language 2 * Serman -

Languages: Allows you to select the description language. This section has the following options:
Language 1: Displays the default language assigned for all descriptions. This field cannot be
changed.

Language 2*: Allows you to select the description languages from the available list of supported
languages. This is a mandatory field.

By default, all supported devices from the Devices section will be selected.

Devices

Select Device name Device type Device Group Area Sector "
GMD MB Standard Devices DefaultArea
p850_P2 P850 Standard Devices DefaultArea
PAC1200_project2 PAC1200 Standard Devices PACdevices
PAC1500_P2 PAC1500 Standard Devices PACdevices
PAC1661_P2 PAC1651 Standard Devices PACdevices
pac1651_p2 PAC1651 Standard Devices DefaultArea
PAC1661_P2 1 PAC1661 Standard Devices DefaultArea
PAC1662_P2 PAC1661 Standard Devices PACdevices
PAC1665_P2 1 PAC1665 Standard Devices DefaultArea
PAC1682_P2_1 PAC1682 Standard Devices DefaultArea
PAC2200_P2 PAC2200 Standard Devices PACdevices
PAC3200_P2 PAC3200 Standard Devices Area_Level PAC
PAC4200_P2 PAC4200 Standard Devices System_Level
SEM3_P2 SEM3_SEM3 Standard Devices PACdevices
O Manual_measure_P2 ingDevice Standard Devices DefaultAr v

Hotes 1. Manual Measuring Device, Load Monitoring, and Limit Control device types are not supported for migration.
2. Generic Modbus Device, 3VLCOM21, and PAC1500 device types will be considered as third party device types in new powermanager after migration.

Devices: Allows you to select the device configurations to be migrated. This section has the
following columns:
Select: Select the checkbox under this section to select the device. All the devices supported for
migration is selected by default. Migration non-supported devices are highlighted in grey and
cannot be selected for migration. Such devices are not migrated even as Third-party devices.
Device Name: Displays the name of the selected device.
Device Type: Displays the device type.
Device Group: Displays the device group.
Area: Displays the area under which the device is available.
Sector: Displays the sector hierarchy under which the device is available.

NOTE: Device passwords are not included in the migration operation. Update the device passwords in

new Powermanager after the completion of migration.
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e Select the required third-party device type XMLs under the Select Third Party Device XMLs
section.

Third Party Device XMLs

Third Party Device Type Number of Devices for the device type Select XML file used for creating the third-party device type Path of XML

CamilleBauer EMMOD_201 0 Browse C:/TPD/CamilleBauer EMMOD_201_v1.0.1/CamilleBauer EMMOD_201
PAC3200TPD 1 Browse C:/TPD/PAC3200TPD/PAC3200TPD xml

SICAM_Q100 1 Browse iC/TPD/SICAM_Q100_v1.0.0/SICAM_Q100.xml

e Select Third Party Device XMLs: Allows you to select the required third-party device type XML to be
migrated. This section has the following columns:

Third-Party Device Type: Displays the third-party device type
Number of Devices for the device type: Displays the number of devices of the device type.
Select XML file used for creating the third-party device type: Allows you select the third-party
device type XML files.
Path of XML: Displays the location of the third-party device type XML files.

e C(Click Save.

NOTE: You must select the XML files for all the third-party devices selected in the Devices section.

Report Templates Tab
e By default, all the Report Templates will be selected. De-select any report templates if
required.

Report Templates

Select Report Template Report Type il
%] AbsaluteEnergyTemplt Absolute Energy
%) abs_logical Absolute Energy
=] CostCenterTempit Cost Center
%] EnergyAnalysisTemplt Energy Analysis
%] EnergyExportTemplt Energy Export
%] KPTemplt KPI
%) kpitemp2 KPI
k4 LoadDurationTemplt Load Duration
%] LoadVarianceTempit Load Variance
=] StandardTemplt Standard
=i StandardThirdParty Standard
%) Standard_sensor Standard
=) standardtemp2 Standard
] std_blank Standard
=] TotalEnergyTemplt Total Energy
% Top_10_Active_Energy Top 10 Energy
=) Top_10_Reactive_Energy Top 10 Energy
=] PowerPeak_Template Power Peak |

Notes: 1. The tool does not creats any back up of the generated reports. Create a back up of all generated reports manually, if requirad.
2. Sankey report templates will not be migrated.
3.Top 10 active & reactive energy and configured power peak analysis will be exporled as report templates.

Report Templates: Allows you to select the report templates. This section has the following
columns.
Select: Select the checkbox under this section to select the required report template. All the
report templates are selected by default.
Report Template: Displays the report template name.
Report Type: Displays the report type.

NOTE: 1) Only report templates are migrated and not the generated reports.
2) Migration is not supported for Sankey Report.
3) Only scheduling configuration of the Top 10 report templates is migrated.
4) The Power peak analysis is migrated as a report template.

Powermanager, Migration Tool 13 0of 35
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5) KPl and Energy Export report templates are migrated as Standard report templates in
new Powermanager.

Click Save.

Miscellaneous Tab

14 of 35

Create email configurations backup under the E-mail Configurations section.
E-mail Configurations

The e-maill configuratiens will not e migrated Do you want to generate a backup file with email conflgurations?

(@) Yes ) Mo

E-mail Configurations: Allows you to create a backup of the email configurations.

Select Yes to create a backup of all email configurations.

NOTE: We recommend you create a backup of the email configurations. The backup file is not
imported as a part of the migration import operation. Refer the backup file to configure the E-mail
in new Powermanager.

Create reactions backup under the Reaction Plans section.

Reaction Plans
The reaction pdans will not be migrated. Do you want to generate a backup file with reaction plans?

-~

() Yes () Mo

Reaction Plans: Allows you to create a backup of the reactions.

Select Yes to create the backup of all reactions.

NOTE: We recommend you create a backup of the reactions. The backup file is not imported as a
part of the migration import operation. Refer the backup file to configure the reactions in new
Powermanager.

Create system alarms backup under the System Alarms section.

System Alarms

The systern alarms will not be migrated. Do you want to genarate a backup fila with system alarms?

P

(®) Yes () Mo

System Alarms: Allows you to create a backup of the system alarms.

Select Yes to create backup of all system alarms.

NOTE: We recommend you create a backup of the system alarms. The backup file is not imported
as a part of the migration import operation.

Migrate system settings under the System Settings section.
System Settings

Do you want to migrate system level setfings?

(®) Yes ) Mo

System Settings: Allows you to migrate all system settings.
Select Yes to migrate all system settings and configurations.

Powermanager, Migration Tool
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All archive smoothing, driver smoothing, system dashboard, and synchronization configurations are
included.

e Migrate system trends under the System Trends section.
System Trends

Do you want o migrate system trends?

(@) Yes ) Mo

System Trends: Allows you to migrate all system trends.
Select Yes to migrate all system trends.

o (lick Save.

Export Tab

e Select the path for the export and complete the configurations export under the Export
Configuration section.

Export Configuration

Select a patn to expor the configuration

Path | D /SENTRON/PowermanagerProject/data/M _Export

Export Configuration

Path: Allows you to select the path to where the files need to be exported to.
Export Configuration: Allows you to complete the complete configurations export.

The file containing the configurations export is available in the above specified folder.
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3.3 Data Export

Archived data over required period for selected devices is also a part of this operation. To perform

data export, ensure that the configuration export is complete, and all the prerequisites mentioned

the Prerequisites for Export section are met. Perform the following steps for data export.

Measurement Points Tab

16 of 35

Standard Devices
Select Archive Configuration

(@) Defaut (O Cusrent

Devices
{3VA2TBreaker (3VAZT)
IVAETUSBreaker (3VAETUS)
IVAETUBBreaker (3VAETUS)
JVLCOM21Breaker (3VLCOM21)
JWWLBreaker (3WL)
JWL10Breaker (IWL10)
GenencModbusDewce (MB)
GenencModbusDewce_1 (MB)
GenencModbusDewce_2 (MB)
P8500evice (PACS5100)
P855Device (PACS200)

PAC1200Device (PAC1200)
€

() Custom

Select Archive Configuration for the measurement points to be migrated.

Devices: Allows you to select the devices for which the data must be exported. All the devices

selected in the configuration export are listed here.

Default: Select to export the measurement points that are archived by default when a device is

created in new Powermanager.

Example: The measurement points archived by default for a PAC3200 device are active energy

import tariff 1 and cumulated active power import.

Measurement Points

Available Measurement Groups

Available Measurement Points

Selected Measurement Points

active energy import tarff 1
(EM) cumulated active power import

[

Mote:  The above tables only show the archived measurement points for each group.
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Current: Select to export all the archived measurement points configured in Powermanager V3.6

HF1.

Measurement Points

Available Measurement Groups

#wailable Measurement Points

Selected Measurement Points
voltage L1-N

woltage L2-N

voltage LIN

current L1

current L2

curent L3

collective apparent powar

collective active power

callective reactive power (VARn)
work hour counter

active energy import tariff 1

active energy export tariff 1

reactive energy import tarifl 1
reactive energy export tanff 1
apparent energy tanii 1

load profila synchronisation
acknowdedge diagnostics

device reset (no change of IP Address)
reset maxima

reset minima

reset energy Counters

relevant param. changes

counter reset

(EM) cumulated active power import
(EM) cumulated active power export
digital output 0

switch output group

Hote:  The above tables only show the archived measurement points for each group.

X

%

Custom: Select to choose measurement points from all the archived measurement points for the
selected device in Powermanager V3.6 HF1.

Measurement Points
Available Measurement Groups
Curment

Power

Power intenal
Power factor

Awailable Measurement Points

oitage L2-1
voltage L3N

Voltage D

Frequency v

Salected Measugment Points
voltage L1-N

Note:  The above tables only show the archived measurement points for each group.

NOTE: Logical devices are not listed for data migration. All the result values are selected for export.

e Select the devices for which the measurement points need to be exported under the Third

Party Devices section.

Powermanager, Migration Tool
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Third Party Devices
Select Archive Configuration

®) Current () Custom

Devices
Schneider_ PMB10Device (Schneider PME810)

Devices: Allows you to select the devices for which the data must be exported. All the third-party
devices selected in the configuration export are listed here.

Current: Select to export all the archived measurement points configured in

Powermanager V3.6 HF1.

Custom: Select to choose measurement points from all the archived measurement points for the
selected device in Powermanager V3.6 HF1.

Click Save.

Duration Tab

18 of 35

Select the duration for which the data must be exported.

Duration for Energy Consumption & Power Interval Values

Select ™ 3 Months M Starttime 2021.04.28 14:08 Endtime |2021.07.28 14.08

Duration for All Other Values

Select 3 Months - Starttime |2021.03.07 16:33 Endtime |2021.07.28 14.08
W] Time Based Smoothing Smoothing Interval 1 hour -
Notes 1. Start and End time format is Y'Y MM DD HH MM

2. Default value of the End time is the completion time of the configuration export

NOTE: The default time duration for the data export is from the selected start time to the time
configuration export is completed.

Duration for Energy Consumption & Power Interval Values: Allows you select the duration for which
the data must be exported for energy consumption and power interval values. This section has the
following options.

Select*: Select the duration for which the data must be exported from this dropdown.

Start time: Displays the start date and time for the selected duration, if the default duration is
selected in the Select* dropdown.

Allows you to select the start time and date, if the custom option is selected in the Select*
dropdown.
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End Time: Displays the end date and time for the selected duration, if the default duration are
selected in the Select* dropdown.

Allows you to select the end time and date, if the custom option is selected in the Select*
dropdown.

Duration for all Other Values: Allows you to select the duration for which the data must be
exported for all other values except energy consumption and power interval values. Default
duration is set to 3 months.

NOTE: Other values data (excluding energy consumption and power interval) can be exported only
for last three months.

Time Based Smoothing: It allows you to reduce the volume of data to be exported.

Smoothing Interval: Select the smoothing interval for time based smoothing. This helps to reduce
the amount of data considered for migration and to reduce the SQL size needed. After the
smoothing interval time has elapsed, the next value will be considered for migration. Any values
during the smoothing interval are discarded.

o Click Save.
Export Tab
e C(lick Calculate Quick Forecast or Calculate Detailed Forecast to view the SQL storage

analysis needed for new Powermanager database.

Forecast

S0L Storage Forecast Quick Analysis

+ =

Calculate Quick Forecast

Shon Term Starage Long Term Storage Total SQL Storage

SOL Storage Forecast Detailed Analysis

Short Term Storage Long Term Storage

+

Calculate Detailed Foracast

Total SQL Storage

SQL Storage Forecast Quick Analysis: Provides you a detailed estimate of the required SQL storage

space.

SQL Storge Forecast Detailed Analysis: Provides you a detailed estimate of the required SQL storage
space. This process can take a few minutes to an hour depending on your data.

e C(lick Data Export in the Data Export section to proceed with the export operation.

Export Data

Data exported will be presentin the below path

Data Export

Export Data: Displays the path where the data export files are made available.

The file containing the data export is available in the above specified folder.
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3.4 Post Export Operations

Perform the following steps to proceed with migration.

e Copy the files containing the configuration and data export to the machine with new
Powermanager.
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4 Import to new Powermanager

This section provides information on the import operation required for migration.

Pre-import Checklist:

e During installation of new Powermanager, select checkbox Migration (select if you are
migrating from Powermanager V3.6 HF1) and click Next.
NOTE: If the checkbox is not selected, Powermanager Migration feature will not be
available after installation.
To add Powermanager Migration feature post installation follow the below steps:
- Launch Powermanager SMC and Navigate to Projects node.
- Click Stop.

System Management Console

“

SIEMENS Active project : Powermanager / stopped e

System
¥ Projects

Project Settings

Powermanager

¥ Weosites
¥ Pomemmanagerwensite (SRRl v server Project nformation
PMDasnboard
PMReports Project status: @ stopped Data version: 60380  PertInformation
PMWebCient
PAAWS! 0 Project name: Powermanager Fmon pors 455
¥ Dataosse Infrastructure ) n Data port:
W (locall\GMS_HDB_EXPRESS Project path: e o P i)
HOB] ! Lenguages: Event port:
NOE [Netifeation] ’ - enls 0 e =1
Certificate = HDB Reader port: )
enGh Distport
deDE Query Cache port s
o P CCom port:
Linked HDE: llocal/\GHS_HOB_EXPRESSIHDE B naypted
Linkad HDB state: Connected - securad
System name: Syste System I0: 1
¥ 4 Distnbution participant: Dist port:
Query Cacher Quary Cache port 4
¥ Extension Information
Name Data Varsion Status
‘Advanced Reporting 6000070 Updated -
Appiication Host Base 600010 Updated
Energy and Power Management Common 600100 Updated
Modbus TCP 600040 Updated
N Madbus TCP Power Devices 60027.0 Updated
ModeMap 6000020 Updated .

» Communication Security

Manager Name Mode Status Options

Process Monitor WCCiLpmon manual ® Stopped 2+

Ready

- Close all the applications related to Powermanager.

- Launch Update Powermanager from desktop.
NOTE: If Update Powermanager is not available on desktop, refer to path
"C:\Siemens\SENTRON\Powermanager\GMSMainProject\Bin\Gms.InstallerSetup.exe"
Administrative rights are required to launch Update Powermanager.
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- Click Yes on User Account Control window.

Siemens.GMS.InstallerSetup

Verified publisher: Siemens AG
File origin: Hard drive on this computer

Show more details

- Click Next.
m SENTRON powermanager . -.) Setup - Server -
Welcome to the SENTRON powermanager Install Wizard.
This wizard will install the management station and its prerequisites on your computer. To continue, click Next.

Select a Language for the Installation Wizard from the choices below.
® en-US
& Warning: This prog is p d by copyright law and international treaties.

Add Additional Language | | Next Cancel
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- Select Server and click Modify for Feature Selection.

m SENTRON powermanager' ) Setup - Server —
Setup Type Selection
Choose a setup type for installation.

® Server Feature Selection

FeP

Back | | Next | | Cancel

- Click Add Em.

m SENTRON powermanager ' _.} Setup - Server —

Feature Selection
Select feature(s) to install.

ect A Deselect Al AddEm | | ok

w
i

Powermanager, Migration Tool 23 of 35
L1V30600299C | Edition 10.2024



24 of 35

Browse for Powermanager setup folder.
Navigate to Powermanager setup folder\DCC\EM\Powermanager_migration and

click OK.

Browse For Folder

4 & EM

‘
i
[
i
!
’
!
i
!
)
n
)
!
’

Advanced_Reporting
Application_Host_Base
D3_Visualization
EnergyAndPowerManagemer
Installer

MNS

Maodbus

NodeMap
PowerManagement_Modbus
Powermanager
Powermanager Migratior

Seripting
SMC
Web_Service_Interface
bk languages
b SR
oK | Cancel
[

Click OK.

m SENTRON powermanager . - Setup - Server

Feature Selection

Select feature(s) to install.

4 Energy and Power
Powermanager Migration

Select All

| [ Deselect A
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- Click Next.

m SENTRON powermanager '+ ) Setup - Server -
Setup Type Selection
Choose a setup type for installation.
® Server Feature Selection
FEP
Back | | Next | | Cancel
- Click Next.
m SENTRON powermanager = ) Setup - Server -
Installation Folder
The setup will use the following folder to install powermanager
Installation folder:
C:\Siemens\SENTRON\powermanager\ SiEIE
[ Name Total size (GB) Free space (GB) Required (GB) Temp (GB) Remaining (GB)
C\ 200.000 5176 0.029 0.029 5117
D\ 275.839 257.117 0.000 0.000 257117
ﬁ Note: Spaces and special characters are not allowed in the installation folder path.
Back | | MNext | | Cancel
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- Click Install.

m SENTRON powermanager \ -._ Setup - Server -

Ready to Install the Program

Following components are ready for installation

Name Status

Powermanager Migration Pending

Back | | Install | | Cancel

- Click Close.

m SENTRON powermanager . _.) Setup - Server -

Installation Complete

Installation successful.

Click Close to exit.
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e Add Powermanager Migration feature in the project using the below steps:
- Launch Powermanager SMC and navigate to Projects node.
- Select project name and click Add to project.

System Management Console
SIEMENS Active project : Powermanager / stopped Meny
System Project Settings Web Services Settings | Notification I
¥ Projects
Powermanager
v webstes
v W“;;“;:;ﬁ“"‘ 3 ¥ Server Project Information -
PMReports Project status: @ stopped Data version: 60380  Port Information
PMweoCiient Pmon port rr
PAWS! a Project name: Fowermanager
¥ Datsbase Infrestructure i .
¥ (local)\GMS_HDB_EXPRESS Project pathc Dataport 4657
HDS [HDB] ’ Languages: B
 NDB [Notification] S nguag s . Event port 1%
Certificate =] HDE Reader port: I
s Dist port:
de DE Query Cache port: i)
o T Com port:
Linked HDB: llocall\GMS_HDE_EXFRESS\HDB. Encrypted:
Linked HDE state: Connected - secured
System name: System System I0: 1
» Distribution participant: Dist port
Quary Cache: Query Cache port 4118
¥ Extension Information
Name Data Version Status |
o Acvanced Reporting 6000070 Updated -
Application Host Base 60001.0 Updated
Energy and Fower Management Comman 600100 Updated
Modbus TCP 600040 Updated
Modbus TCP Power Devices 600270 Updated
Nodemap 6000020 Updated =
Manager Name Wode Status. Options |
Process Monitar WCClLpmon manual ® Stopped =
Ready

- Select Powermanager Migration and click OK.

Select Project

¥ [/] Energy and Power
[+/] Powermanager Migration

- Click Save.
- Start the project.

e Ensure that you have the required new Powermanager license available and activated.
Licensing for Powermanager is controlled through a tool called, License Management Utility (LMU).
Once Powermanager is installed, the License Management Utility (LMU) is installed on every
system.

Before launching the Powermanager client application, you must first enable and manage licenses
for Powermanager. Otherwise, only the demo licenses are configured, and you will need to close
the Powermanager client application in very short time.
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To protect Powermanager against piracy, a special activation is required. You can activate the

license for Powermanager from LMU using the below steps:

- Launch SMC either by double-clicking the SMC icon on the desktop or from
Windows Start menu.

- Refer to Help > Engineering Step-by-Step > Installing the Software > Additional Installer
Procedures > Activating a Customer License.

Ensure that new Powermanager supported version of SQL is available.

Ensure that database size and storage size are sufficient corresponding to the SQL forecast

of the SQL operation.

Ensure that a historical database (HDB) is connected and accessible to the project, the

long-term storages created and switched to ON state.

You can create long term storages using the below steps:

- Launch Powermanager SMC either by double-clicking the SMC icon on the desktop or from
Windows Start menu and click Yes.

- Inthe SMC System tree, select History Infrastructure.

- Click Scan Local.

- When the scan is completed, select GMS_HDB_EXPRESS SQL.

- Click Link.

- Click Add to create the HDB.

- Inthe Long-Term storage section, click Add Storage to create long term storage.

- Select the Start check box for the storage.

- Click Save.

The History Database is created and displays in the SMC tree. This may take a few minutes
depending on the selected database size. When you create a new HDB it gets automatically linked
to the SQL Server. The long-term storage is created when the state in the State column in the
Storage table changes to ON.

For additional information, refer to Powermanager Help >Engineering Step-by-Step > Setting Up the
Project > Creating History Infrastructure > Create a New HDB with Long Term Storage.
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4.1 Prerequisites for Import

Ensure that new Powermanager Server is installed, refer to Readme.pdf (section 4.1 Installation

Prerequisites). You have the privileges of a DefaultAdmins user or a PowermanagerAdmins user.

If user had reports scheduled in Powermanager V3.6 HF1, ensure that Software user account is

created in new Powermanager, and group membership is assigned to PowermanagerAdmins.

Enter created Software account username during configuration import. To create new user,

navigate to Management view > Users.
Refer new Powermanager help section for more details: Engineering Step-by-Step > User and User

Group Administration > User Administration.

NOTE: Migration is not supported for new Powermanager Client setup.

Perform the following steps to proceed with migration:

Copy the files containing the configuration and data export to the machine with new
Powermanager.

Create the third-party device types, if any.

You must create the third-party device type to be migrated in new Powermanager. JSON files for
corresponding third-party device types are created by the migration tool during the configuration
export. These JSON files are available in configuration export folder. You can create third-party
device types using the below steps:

Select Applications > Powermanager.
The System tab displays.

Select Third Party Device Type expander and proceed as follows:
= Dragand drop the library to the Library Name field.
= Click Browse to select the JSON file.

= |nthe Open dialog box, select the required JSON file from the location and click Open.

Click Create Device Type.

NOTE: Device types like 3VLCOM21 and PAC1500 are supported in Powermanager V3.6 HF1 but not
supported in new Powermanager. JSON files for these device types are created as a part of the export

operation.
These files are available in path: [Projectname]_Backup_For_Migration(yyyy-mm-dad-
hh.mm)\Configuration|Device\Classic_DeviceType_Jsons.

Edit the JSON files for the Generic Modbus Device (GMD) types, if any.

A JSON file is created for GMD type by the migration tool during the configuration export. This

JSON file is available in configuration export folder.

Open the JSON file of the GMD type using the Powermanager device engineer tool. Perform the

required property configurations and create the new JSON files for corresponding GMD groups.

Consider the below example to create GMD device type JSON files in Powermanager device

engineer tool:

- Open JSON file GenericModbusDevice_Classic from configuration export folder in third-party
tool PowermanagerDeviceEngineer.
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Review and configure Device Features page properties as per Powermanager V3.6 HF1 and
click Next.

Review and configure Device properties page properties and click Next. Make sure the
property configurations are correct and configured as per Powermanager V3.6 HF1 GMD
device type.

Review and configure Device Configuration and save the JSON file.

If necessary, rename the device type using Edit option from Device Type Name.

NOTE: Do not rename the datapoint properties. If you rename, configuration and data import
failure will occur.

Logical grouping of GMDs:

If multiple GMDs are created with same configuration in Powermanager V3.6 HF1, then during
bulk device creation in new Powermanager, you must select the same device type.
For different GMD configurations of Powermanager V3.6 HF1, individual JSON files should be
configured in Powermanager device engineer tool.
One JSON file should be created for one type of configuration and that type should be selected
during bulk device creation.
Consider the below example to understand logical grouping of GMD and create corresponding
JSON files in Powermanager device engineer tool:
Consider three devices GMD1, GMD2 and GMD3 in Powermanager V3.6 HF1.
GMD 1 has configuration 1 and GMD2 has configuration 2 and GMD3 has similar configuration
as GMD1. In this case user must create two separate GMD device types:

= One device type JSON for GMD1 and GMD3 as they have same configuration

= One device type JSON for GMD?2

Bulk Device Creation gratio Engineering

Select Device Name | Device Description - Default Language (English) | Device Description - Additional Language | Device Type Area °
v ew_s 2w 8R etu_B 3VAETUS Area_level_Inheritance
v CoM_21 CoM_21 COM_21 3VLCOM21_Classic MotSupported_Devices
| 3IWL-sim 3IWL-sim 3IWL-sim 3WL Breakers
v 3IWL_1 3IWL_IR w1 3wl System_level_Inheritence
¥ 3WL_10 3WL_10R 3WL_10 3wLie Area_level_Inheritance
| GMD1 GMD1 GMD1 GenericMedbusDevice_Classic_land3 u Areal
| GMD2 GMD2 GMD2 GenericModbusDevice_Classic_2 n Area2
| GMD3 GMD3 GMD3 GenericModbusDevice_Classic_Tand3 n Areal
| P850-1 PE50-1 PES0-1 PACS100 NotSupported_Devices
| PACPE50_1 PACP850_1 PACP850_1 PACS100 Dummysector2
v P833-1 P855-1R PB35-1 PAC5200 System_level_Inheritence
v 1200-1 1200-1R 1200-1 PAC1200 System_level_Inheritence
v 12002 1200_2 1200_2 PAC1200 Area_PAC |
Il 3
Overwrite if the devices exist Device already exists Error in device specification

Create the devices in new Powermanager under Bulk Devices Creation tab:

In Engineering mode, click Bulk Device Creation.

Browse .csvfile to create devices.

NOTE: A .csvfile with the device configurations is created during the export operation. Use this
.csv to create the devices.
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These files are available in path: [Projectname]_Backup_For_Migration(yyyy-mm-dad-
hh.mm)\Configuration|Device\|BulkDeviceCreation.

- Select the required Device Type from the available dropdown for GMDs.

- Provide the Username and Password for all SEM3 devices.

- Import the JSON files to new Powermanager to work with these devices. Refer steps from
section 4.1 Prerequisites for Import > Create the third-party device types to import JSON files
to new Powermanager.

- Click Create Devices.

e Switch to operating mode and start all device communication.

e Switch to Engineering mode and navigate to Migration tab to proceed with the import
operation.

Powermanager -

Select the folder with the migrated files.

Siep 1 - Configuration Import
Enter Schedule Report details.

Username Select path

Import
e

| |
Step 2 - Data Import

Complete configuration import to proceed with data import.
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4.2 Configuration and Data import

Perform the following steps to proceed with configuration import.

320f35

Select the folder with the migrated files under the Import expander.

Powermanager

Select the folder with the migrated files.
CA3x_projectfiles\Migration_test\NEw_toaiTest_1_Backup_For_Migration(2022-01-25-19.12) m

Select the folder exported from Powermanager V3.6 HF1: Allows you to select the folder with the
configuration or the data export.

Step 1 — Configuration Import: Allows you to import the file containing the configurations.
Username: Enter software account username for new Powermanager.
Select path: Select the folder to export the schedule reports.

Powermanager

Select the folder with the migrated files,
C4\3x_projectfiles\Migration_test\MEw_too/\Test_1_Backup_For_Migration(2022-01-25-19.12) | Browse |

Step 1 - Configuration Import
Enter Schedule Report details.

Username Select path
L ] =

|
Step 2 - Data Import

Complete configuration import to proceed with data import.

Step 2 — Data Import: Allows you to import the file containing the data.

MODBUS Configuration

Device Type Configuration | Bulk Device Creation Migration

Powermanager

Select the folder with the migrated files.
C\3x_projectfiles\Migration_testiNEw_tool\Test_1_Backup_For_Migration(2022-01-25-19,12) m

Step 1 - Configuration Import

Q Configuration import successful, A migration import summary is created with configuration import details in <Project Path>/Data/Migration. ‘
|
Step 2 - Data Import

The configuration and the data import are successful.
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MODBUS Configuration

Device Type Configuration | Bulk Device Creation

Powermanager

Select the folder with the migrated files.
©43x projectfiles\Migration test\MEw_ tool\Test 1 Backup For Migration(2022-01-25-19.12) E=S

Step 1 - Configuration Import

o Configuration import successful. A migration import summary is created with configuration import details in <Project Path>/Data/Migration. ‘
|

Step 2 - Data Import

° Data impert successful. The migration import summary is updated with data import details in <Project Path>/Data/Migration. ‘

NOTE: You are recommended to verify all the configurations in new Powermanager
system after migration.
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5 Migration Summary

Configuration Export, Data Export, Configuration Import and Data Import are the activities
performed during migration. After every export and import activity, migration summary report will
be created for each activity.

Export summary will be available as <Exported Folder>/Migration_Export_Summary.txt

Import summary will be available as

<Project Path>/Data/Migration/Migration_Import_Summary.txt

NOTE: You can compare between export and import summary reports to get the migration status.
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6 Troubleshooting

Troubleshooting

Error

Situation

What to do

Data import could not start

User clicks on data
import with incorrect
HDB configuration

1.Verify if HDB is linked to the
project.

2 Verify if Siemens GMS HDB service
is running in SMC (system node
>management tab >services
section).

3.Verify if short term and long term
archives/storages are created in
HDB and in ON state.

After performing above
troubleshooting, proceed with data
import.

Migration tab is not available after login
to new Powermanager

Migration EM is not
installed or not added in
the project

If Migration EM is not installed,
refer section Import to new
Powermanager.

If migration EM is not added in the
project, click Add to project and add
Powermanager migration EM.

Server is not properly running during
import in new Powermanager

Migration(import)
running on HDB writer
manager goes to blocked
state in SMC

User should wait till completion of
complete migration activity.

The scheduled report file is corrupted

User trying to open the
generated scheduled
report file

In Powermanager application re-
save the report definition.

1. Read the notes in the Readme.pdf file carefully.

2. For up-to-date hot fixes / service packs for Powermanager see:

www.siemens.com/Powermanager/support

For further support, see the Technical Support information below.

Technical Support:

Internet: http://www.siemens.com/lowvoltage/technical-support
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